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Residue Curve Maps in Aspen Plus® V8.0 

1. Lesson Objectives 
 Learn how to create residue maps 

 Understand the basic concepts of a residue curve map 

 Use residue curve maps to guide distillation column synthesis and simulation 

2. Prerequisites 
 Aspen Plus V8.0 

 Introduction to distillation 

3. Background 
For separation processes involving azeotropes, residue curve maps can provide insight to what products are 

feasible for a given feed in a distillation column.  Here are some important concepts related to residue curv e 

maps: 

 Pure species and azeotropes are nodes in a residue curve map  

 Residue curves that contain more than two nodes form distillation boundaries  

 Distillation boundaries divide the residue curve map into distillation regions 

 Distillation boundaries cannot be crossed in a single distillation column 

When searching for a solvent, residue curve maps are typically used to determine how to get one pure 

component from the first column and how to recover solvent from the second column.  After you select the 

solvent and decide the purposes of both main column and solvent recovery column, residue curve maps can 

provide clues on how much solvent to use in the main column so that the column does what you want.   

The examples presented are solely intended to illustrate specific concepts and principles.  They may not 

reflect an industrial application or real situation. 
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4. Aspen Plus Solution 
If you are unfamiliar with how to start Aspen Plus, select components, define methods, or construct a flowsheet, 

consult Get Started Guide for New Users of Aspen Plus.pdf for instructions. 

4.01. This simulation will be a separation of ethanol and water using cyclohexane.  Create a new simulation in 

Aspen Plus using the Blank Simulation template. 

4.02. The Components | Specification | Selection sheet is displayed.  Enter WATER and ETHANOL in the 

Component ID column.  Note that Component name and Alias are filled automatically for these two 

components.   In the third row of the grid, enter CYCLOHEXANE for Component name.  Enter CYCLO-01 

as Component ID for the third component.  Alternatively, you can click the Find button and use search 

capability to enter the third component.  We select these three components for residue curve map 

study because sometimes cyclohexane is used as the solvent for separation of ethanol and water via 

azeotropic distillation. 
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4.03. Next, we will be selecting the physical property method.  We will be using UNIQ-RK, which is a UNIQAC 

method for liquid-liquid systems with Redlich-Kwong for the vapor phase equation of state.  Go to the 

Methods | Specifications | Global sheet.  Note that when Method filter is COMMON, UNIQ-RK is not 

available on the drop-down list for Base method.  So, set the Method filter to ALL, and then select 

UNIQ-RK for Base method. 
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4.04. Press F4 or click Next Input.  Note that the Methods | Parameters | Binary Interaction | UNIQ-1 | Input 

sheet is displayed and binary parameters are filled automatically.  

 

4.05. Next, we will set up the parameters for the residue curve map.  To create a residue curve map, click  the 

Analysis | Residue Curves button under the Home tab of the ribbon. 
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4.06. The Distillation Synthesis window appears.  Note that there is a button called Find Azeotropes in this 

window.  When you work on projects to resolve real engineering problems, it is criti cally important to 

validate the simulator’s prediction.  You may click the Find Azeotropes button to get azeotropes 

predicted by Aspen Plus.  Then, retrieve NIST experimental data for azeotropes so that you can compare 

model prediction against experimental data to determine whether the selected thermodynamics model 

in Aspen Plus is appropriate.  In example Thermo-007, step 4.17 describes how to retrieve data from 

NIST.  Next, we will generate residue curve map by clicking the Continue to Aspen Plus Residue Curves 

button. 
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4.07. Note that the Analysis | RESID-1 | Input | Residue Curve sheet is displayed.  On the sheet, most of the 

defaults will be acceptable with a few exceptions.  In the Number of curves frame, select 15-20 Curves. 

Change Valid Phases to Vapor-Liquid-Liquid, which will tell Aspen Plus to check for a second liquid 

phase during calculations. 
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4.08. Go to the Analysis | RESID-1 | Input | Diagnostics sheet.  Set Error tolerance to 1e-05.  This is to 

improve the accuracy of the residue curve map.  
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4.09. Go back to the Analysis | RESID-1 | Input | Residue Curve sheet and click the Run Analysis button on 

the sheet.  A residue curve map should appear in a new tab. 

4.10. Now we have a residue curve map.  There is a ternary azeotrope close to the center of the composition  

space.  The residue curve lines may also display individual data points depending on the default settings 

of Aspen Plus on your machine.  Since (1) the ternary azeotrope has the lowest temperature compared 

with binary azeotropes and boiling point of pure components and (2) binary azeotropes have lower 

temperatures than any of the boiling points of any one of the three pure components, each residue 

curve goes from the ternary azeotrope to a pure component.  This is useful in determining which pure 

component can be obtained from a distillation column.  The appearance of the plot can be changed 

under the Format tab of the ribbon. 
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4.11. Click the Format tab of the ribbon.  We will see various options to change the appearance of the plot.  

To make the plot easier to read, we will tell Aspen Plus to not display the individual data points on the 

graph.  To do this, select Lines Only in the Display drop-down list.  Various other display options are 

available in this section. 

 

4.12. Since we are using cyclohexane as the solvent to separate ethanol and water, we need to get one pure 

component (water or ethanol) from the first column.  The residue curve map tells us that we will get a 

pure component from the bottom of the first column.  From the top of  the first column, we will get a 

mixture around the ternary azeotrope.  So, we will try different solvent flowrates to see what we will get 

from the bottom of the first column.  Move to the simulation environment by clicking the Simulation bar 

in the navigation pane. 

4.13. Create a simple flowsheet with a RadFrac column that has FEED and SOLVENT as inlet streams, and TOP-

PROD as the liquid condensate, and BOT-PROD as the bottoms product. 
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4.14. Go to the Streams | FEED | Input | Mixed sheet.  Select Vapor Fraction and Pressure for Flash Type.  In 

the State variables frame, set Pressure to 1 bar, and Vapor fraction to 0.3.  In the Composition frame, 

select Mole-Flow and kmol/hr and specify 13 for WATER and 87 for ETHANOL. 

 

4.15. Go to the Streams | SOLVENT | Input | Mixed sheet.  Select Vapor Fraction and Pressure for Flash 

Type.  In the State variables frame, set Vapor fraction to 0 and Pressure to 1 bar.  We purposely do not 

specify flowrate for SOLVENT. 
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4.16. Go to the Blocks | COLUMN | Specifications | Setup | Configuration sheet.  Enter 33 for Number of 

stages, Total for Condenser and Vapor-Liquid-Liquid for Valid phases.  Set Reflux Ratio to 3.5 on Mole 

basis.   
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4.17. Go to the Blocks | COLUMN | Specifications | Setup | Streams sheet.  For the Stage column in the Feed 

streams frame, enter 1 for SOLVENT and 20 for FEED. 
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4.18. Go to the Blocks | COLUMN | Specifications | Setup | Pressure sheet.  Set the Stage 1 / Condenser 

Pressure and the Stage 2 Pressure to 1 bar. 
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4.19. Go to the Blocks | COLUMN | Specifications | Setup | 3-Phase sheet.  Enter 1 for Starting stage and 33 

for Ending stage.  Specify WATER as Key components in the Key components to identify 2nd liquid 

phase frame.  This tells Aspen Plus that we expect the second liquid phase to be predominantly water, 

and since we do not really know which stages will contain two liquid phases, we will  ask Aspen Plus to 

check every stage. 
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4.20. Go to the Blocks | COLUMN | Convergence | Convergence | Basic sheet.  Enter 200 for Maximum 

iterations.   
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4.21. Save the simulation.  On the ribbon, click File and then click Save As to save the simulation as Thermo-

021_Base.bkp.   This is the base file that will be used as the starting point for the following three case 

studies associated with three different SOLVENT flowrates.  Now, close the Aspen Plus Window. 

4.22. Start the first case study – How to obtain pure water from the bottom of the distillation column.  In 

Windows Explorer, make a copy of Thermo-021_Base.bkp and rename the new file to Thermo-

021_Water.bkp.  Double click Thermo-021_Water.bkp to load it into the Aspen Plus UI.   

4.23. Go to the Streams | SOLVENT | Input | Mixed sheet.  In the Composition frame, enter 30 for CYCLO-01.   

 

4.24. Go to the Blocks | COLUMN | Specifications | Setup | Configuration sheet.  Select Strongly non-ideal 

liquid for Convergence.  In the Operating specifications frame, select Bottoms rate as the second 

specification and enter 30 kmol/hr for Bottoms rate.   
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4.25. In the navigation pane, select Blocks | COLUMN | Specifications | Design Specifications.  The object 

manager for Design Specs is displayed.  Click the New… button to create a Design Specs called 1. 

 

4.26. Go to the Blocks | COLUMN | Specifications | Design Specifications | 1 | Specifications sheet.  Select 

Mole purity for Type.  Enter 0.95 for Target. 
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4.27. Go to the Blocks | COLUMN | Specifications | Design Specifications | 1 | Components sheet.  Select 

WATER for Components.  Select all three components as Base components. 

 

4.28. Go to the Blocks | COLUMN | Specifications | Design Specifications | 1 | Feed/Product Streams sheet.  

Select BOT-PROD as Selected stream in Product streams frame. 
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4.29. In the navigation pane, select Blocks | COLUMN | Specifications | Vary.  Object manager for Vary is 

displayed.  Click the New… button to create a Vary called 1. 

 

4.30. Go to the Blocks | COLUMN | Specifications | Vary | 1 | Specifications sheet.  Select Bottoms rate for 

Type.  Enter 1 for Lower bound and 100 for Upper bound. 
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4.31. Press F5 to run the simulation and the simulation should complete without errors or warnings.  Go to 

the Blocks | COLUMN | Specifications | Vary | 1 | Results sheet.  Note that the Final value for MOLAR 

BOTTOMS RATE is 1.40901 kmol/hr.  The small bottoms rate is OK because azeotropic distillation 

processes typically include a second column and there is typically a recycle stream from the second 

column back to the first one.  After the whole process converges, the bottoms rate will be very close to 

the flowrate of water in stream FEED.  

  

4.32. Go to the Blocks | COLUMN | Profiles | Compositions sheet.  Select Liquid for View.  Note that the 

bottom stage composition for WATER is 0.95, which means that we can get pure water from the bottom 

of the column. 
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4.33. Press Ctrl + S to save the simulation.  Close the Aspen Plus UI Window.   This concludes our first case 

study.   

4.34. Start the second case study – How to obtain pure ethanol from the bottom of the distillation column.   

4.35. In Windows Explorer, make a copy of Thermo-021_Base.bkp and rename the new file to Thermo-

021_Ethanol.bkp.  Double click the Thermo-021_ Ethanol.bkp to load it into the Aspen Plus UI.   

4.36. Go to the Streams | SOLVENT | Input | Mixed sheet.  In the Composition frame, enter 100 kmol/hr for 

CYCLO-01.   

4.37. Go to the Blocks | COLUMN | Specifications | Setup | Configuration sheet.  Select Azeotropic for 

Convergence.  In the Operating specifications frame, select Bottoms rate as the second specification 

and enter 33 kmol/hr for Bottoms rate.   

4.38. Press F5 to run the simulation and the simulation completes without any error or warning. 

4.39. Change convergence parameters to make convergence more robust because this is a difficult case in 

terms of convergence.  Go to the Blocks | COLUMN | Specifications | Setup | Configuration sheet.  

Select Custom for Convergence.  Go to the Blocks | COLUMN | Convergence | Estimates | 

Temperature sheet.  Click the Generate Estimates… button.  In the pop up dialog box, make selections 

as shown in screenshot below so that we generate all possible estimates and Keep all available digits.  

Click the Generate button and wait for it to complete. 
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4.40. Go to the Blocks | COLUMN | Convergence | Convergence | Basic sheet.  Select Newton for Algorithm.  

Go to the Blocks | COLUMN | Convergence | Convergence | Advanced sheet.  Select Dogleg strategy 

for Stable-Meth. 

4.41. In the navigation pane, select the Blocks | COLUMN | Specifications | Design Specifications.  The object 

manager for Design Specifications is displayed.  Click the New… button to create a Design Spec called 1. 

4.42. Go to the Blocks | COLUMN | Specifications | Design Specifications | 1 | Specifications sheet.  Select 

Mole purity for Type.  Enter 0.9 for Target. 

4.43. Go to the Blocks | COLUMN | Specifications | Design Specifications | 1 | Components sheet.  Select 

ETHANOL for Components.  Select all three components as Base components. 

4.44. Go to the Blocks | COLUMN | Specifications | Design Specifications | 1 | Feed/Product Streams sheet.  

Select BOT-PROD as Selected stream in Product streams frame. 

4.45. In the navigation pane, select the Blocks | COLUMN | Specifications | Vary.  Object manager for Vary is 

displayed.  Click the New… to create a Vary called 1. 

4.46. Go to the Blocks | COLUMN | Specifications | Vary | 1 | Specifications sheet.  Select Bottoms rate for 

Type.  Enter 1 for Lower bound and 100 for Upper bound. 

4.47. Re-initialize the simulation by click the Run | Reinitialize button in the Home tab of the ribbon.  Click OK 

twice.  Press F5 to run the simulation and the simulation completes without any error or warning. 

4.48. Go to the Blocks | COLUMN | Specifications | Design Specifications | 1 | Specifications sheet.  Change 

Target to 0.95.  Press F5 to run simulation.  Change Target to 0.99 and press F5 to run again.  Change 

Target to 0.999 and press F5 to run again. 

4.49. Go to the Blocks | COLUMN | Convergence | Estimates | Temperature sheet.  Click the Generate 

Estimates… button.  In the pop up dialog box, make selections to generate all possible estimates and 

Keep all available digits.  Click the Generate button and wait for it to complete. 

4.50. Re-initialize the simulation by click the Run | Reinitialize button in the Home tab of the ribbon.  Click OK 

twice.  Press F5 to run the simulation and the simulation completes quickly without any error or warning.  

4.51. Go to the Blocks | COLUMN | Specifications | Vary | 1 | Results sheet.  Note that the Final value for 

MOLAR BOTTOMS RATE is 33.5631 kmol/hr.   

4.52. Go to the Blocks | COLUMN | Profiles | Compositions sheet.  Select Liquid for View.  Note that the 

bottom stage composition for ETHANOL is 0.999, which means that we can get pure ethanol from the 

bottom of the column. 

4.53. Press Ctrl + S to save the simulation.  Close the Aspen Plus UI Window.   This concludes our second case 

study.   
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4.54. Start the third case study – How to obtain pure cyclohexane from the bottom of the distillation column.  

Although, as an end goal, we don’t want to get pure cyclohexane from the first column, it is still 

meaningful to conduct this case study.  After this case study, if you get pure cyclohexane from the 

column, you know that you have too much solvent.  This experience is use ful when you try to achieve 

convergence for a column where you want to get pure ethanol or pure water.  

4.55. In Windows Explorer, make a copy of Thermo-021_Base.bkp and rename the new file to Thermo-

021_Cyclohexane.bkp.  Double click the Thermo-021_ Cyclohexane.bkp to load it into the Aspen Plus 

UI.   

4.56. Go to the Streams | SOLVENT | Input | Mixed sheet.  In the Composition frame, enter 200 kmol/hr for 

CYCLO-01.   

4.57. Go to the Blocks | COLUMN | Specifications | Setup | Configuration sheet.  Select Strongly non-ideal 

liquid for Convergence.  In Operating specifications frame, select Bottoms rate as the second 

specification and enter 33 kmol/hr for Bottoms rate.   

4.58. Press F5 to run the simulation and the simulation completes without any error or warning.   

4.59. Go to the Blocks | COLUMN | Profiles | Compositions sheet.  Select Liquid for View.  Note that the 

bottom stage composition for CYCLO-01 is 1, which means that we get pure cyclohexane from the 

bottom of the column. 

4.60. Press Ctrl + S to save the simulation.  Close the Aspen Plus UI Window.   This concludes our third case 

study.   

5. Conclusions 
The residue curve map for a ternary system provides a clear picture of distillation regions and boundaries.  

Residue curves on the map also provide clear guidance of what will come out of top and bottom of a distillation 

column for a given feed composition. Our three case studies in this example confirmed guidance provided by 

residue the curve map. Of course, we need good simulators such as Aspen Plus and good skills in using 

simulation to translate good guidance into good engineering solutions. 
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